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1.Files and folders deleted from the hard disk of a computer get stored
temporarily in ________ .
कं प्यूटर की हार्ड डि से डिलीट की गई फ़ाइलें और फ़ोर्स अस्थायी प से कहाँ स्टोर हो
जाती हैं?  

*
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Scheme

Authority

Display

Query

1/1

binary

octal

decimal

hexadecimal

1/1

Tab

Ctrl + Tab

Ctrl + Alt + Tab

Shift + Tab

2.Which of the following is NOT contained in Uniform Resource Identifier
निम्नलिखित में से कौन-सा, यूनिफ़ॉर्म रिसोर्स आइडेंटिफ़ायर (Uniform Resource
Identifier) में शामिल नहीं  है?  

*

3.A computer works on a/an _______ number system.
  एक कं प्यूटर एक ________ संख्या णाली (number system) पर काम करता है।  

*

4.What is the keyboard shortcut to move to the next suggestion with
Automatic Word Completion in OpenOffice Writer 3?
  ओपनऑफिस राइटर 3 (OpenOffice Writer 3) में, ऑटोमेटिक वर्ड कं प्लीशन के
साथ अगले सजेशन (suggestion) पर जाने के  लिए कीबोर्ड शॉर्टकट क्या है?  

*
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an optical disk

a magnetic disk

a magnetic tape

a flash device

1/1

OFFSET

REFOFFSET

OFFSETREF

OFFSETREFR

5.DVD is an example of ______.
  डीवीडी (DVD) '___________' का एक उदाहरण हैI  

*

6.Which of the following function of MS-Excel 2019 returns a reference to
a range that is a specified number of rows and columns from a cell or
range ofcells?
  MS-Excel 2019 का निम्नलिखित में से कौन-सा फं न, एक रेंज का रेफरेंस रिटर्न करता
है जो किसी सेल या सेलों के  रेंज से पंक्तियों (rows) यों और स्तंभों (columns) भों की
एक निर्दि  संख्या है?  

*
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Keyboard

Touch Screen

Plotter

Speakers

1/1

scanner

keyboard

mouse

printer

7.Which of the following device can be used as both input and output
deviceWhich of the following device can be used as both input and
output device
  निम्नलिखित में से किस डिवाइस का उपयोग इनपुट और आउटपुट डिवाइस दोनों के  प
में किया जा सकता है?  

*

8. Dot matrix is a type of a ______.
  डॉट-मैट्रि  एक______ का कार है।  

*
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Only (i)

Only (ii)

Both (i) & (ii)

Neither (i) nor (ii)

1/1

CCD scanner

Omni-directional barcode scanner

Pen wand

Inkjet reader

9.Which of the following statements is/are true with reference to mail
merge in MS-Word 365?
(i) You cannot add attachments while sending individual messages to
each email address using mail merge.
(ii) You can include links while sending individual message to each email
address using Mail merge.
  MS-Word 365 में, मेल मर्ज के  संदर्भ में निम्नलिखित में से कौन-सा/से कथन स है/हैं?
(i) आप मेल मर्ज का उपयोग करके  त्येक ईमेल एड्रे स पर अलग-अलग मेसेज भेजते
समय अनुलक (attachments) ऐड नहीं  कर सकते हैं। (ii) आप मेल मर्ज का उपयोग
करके  त्येक ईमेल एड्रे स पर अलग-अलग मेसेज भेजते समय लिंक शामिल कर सकते हैं।
  

*

10.Which of the following is NOT a type of a barcode reader?
निम्नलिखित में से कौन-सा बारकोड रीडर का एक कार नहीं  है  

*
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Domain Name System

Network Topology

Network Interface Card

Uniform Resource Locator

1/1

Magnetic disk

CD

Blu-ray disk

Magnetic tape

1/1

readers

scanners

printers

plotters

11.Which of the following domains is used to map an address to a name
when a server request has received a request from a client to do a task?
  जब सर्वर रिक्वे  को किसी क्लाइंट से कोई कार्य करने का रिक्वे  प्रा होता है, तो किसी
एड्रे स को नाम से मैप करने के  लिए निम्नलिखित में से किस डोमेन का उपयोग किया जाता
है?  

*

12.Which of the following is an optical storage device that uses a laser to
read and write to the disk using a red laser beam?
निम्नलिखित में से कौन सा एक ऑप्टिकल स्टोरेज डिवाइस है जो लाल लेजर बीम का
उपयोग करके  डि पर पढ़ने और लिखने के  लिए लेजर का उपयोग करता है?  

*

13.Drum and flatbed are types of _______.
  ड्र म और फ्लैटबेड _______ के  कार हैं  

*
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Mesh topology

Bus topology

Ring topology

Star topology

1/1

Option 1Vacuum tube

Integrated circuit

Microprocessor

Magnetic drum

1/1

Sheet1

Sheet_1

Sheet-1

Sheet@1

14.Which of the following network topologies has all the computers
connected through a single cable?
निम्नलिखित में से किस नेटवर्क  टोपोलॉजी में सभी कं प्यूटर एक ही के बल से जुड़े ए होते
हैं?   

*

15.Which of the following is a small electronic circuit printed on a chip
that contains many of its own circuit elements (e.g. transistors, diodes,
resistors, etc.)?
निम्नलिखित में से कौन-सा, एक चिप पर प्रिंट किया गया एक छोटा इलेक्ट्रॉ  निक सर्कि ट है
जिसमें इसके  कई सर्कि ट अवयव (जैसे ट्रां  जिर, डायोड, रे सिर्स, आदि) होते हैं?  

*

16.By default, MS-Excel 2019 names a worksheet as_______.
डिफ़ॉ प से, MS-Excel 2019, एक वर्क शीट को _______ नाम देता है  

*
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Pool

Spooler

Drivers

Operating system

1/1

Network server

SMTP

DHCP

POP3

17.Which computer program sequences print jobs by temporarily storing
them in a buffer and sending each one to the printer when the printer is
able to processit?
निम्नलिखित में से कौन-सा एक कं प्यूटर प्रोग्राम, प्रिंट जॉब को बफर में अस्थायी प से स्टोर
करके  अनुमित करता है और जब प्रिंटर इसे प्रोसेस करने में सम होता है, तब त्येक को
प्रिंटर तक भेजता है?  

*

18.Which protocol is used for assigning IP Address in a network
dynamically?
  किसी नेटवर्क  में गतिशील प से (dynamically) IP एड्रे स असाइन करने के  लिए किस
प्रोटोकॉल का उपयोग किया जाता है?  

*
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Alt + Spacebar

Ctrl + Spacebar

Shift + Spacebar

Caps Lock + Spacebar

1/1

compression/decompression

encoder/decoder

enhancer/de-enhancer

sampler/de-sampler

19.Which of the following is a keyboard short cut to select a column in an
MS-Excel 2019 worksheet?
  एमएस-एक्सेल 2019 (MS-Excel 2019) वर्क शीट में, किसी कॉलम को सेले करने के
लिए निम्नलिखित में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता है?  

*

20.With reference to reducing the number of bytes consumed by large
files in computers, Codec stands for ____________.
  कं प्यूटर्स में बड़ी फाइलों द्वारा कं ज्यूम की जाने वाली बाइट्स की संख्या को कम करने
के  संदर्भ में, कोडेक (Codec) का तार्य ____________ है।   

*
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Trimming

Streaming

Watching

Quantizing

1/1

Clean

Upgrade

Uninstall

Unclean

1/1

Internet Protocol version 6

Internet Protocol verification 6

Internet Product version 6

Internet Protocol validation 6

21.Which of the following is a type of media technology that delivers
video and audio content to your Internet-connected device?
निम्नलिखित में से कौन-सा, मीडिया टेक्नोलॉजी का एक कार है जो इंटरनेट से जुड़े
डिवाइस पर वीडियो और ऑडियो कं टेंट डिलीवर करती है?  

*

22.Which of the following types of installation is done when you don't
want to upgrade from existing Windows?
  जब आप मौजूदा विंडोज से अपग्रेड नहीं  करना चाहते हैं, तो निम्नलिखित में से कौन-सा
इंस्टॉलेशन किया जाता है?  

*

23.What does IPv6 stand for?
  IPv6 का पूर्ण क्या है?   

*
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Bootos.exe

Bootmbr.exe

Bootrec.exe

Booting.exe

1/1

Right click -> Properties-> General -> Folder option

Right click -> Properties -> General -> Folder Pictures

Right click on folder -> Properties -> Customize -> Folder icons

Right click -> Properties -> General -> Advanced

1/1

File system

Kernel

Commands

User interface

24.If the MBR of your system is corrupted, which tool can recover it and
boot Windows 10 normally?
  यदि आपके  सिम का MBR कर हो गया है, तो निम्नलिखित में से कौन-सा टू ल इसे
रिकवर कर सकता है और विंडोज 10 (Windows 10) को सामा प से बूट कर सकता
है?  

*

25.How is the icon of a Desktop folder changed in Windows 10?
  विंडोज 10 (Windows 10) में, डेटॉप फ़ोर का आइकन कै से बदला जाता है?  

*

26.Which of the following keep(s) the track of files and directories in
Operating System?
निम्नलिखित में से कौन-सा, ऑपरे टिंग सिम में फाइलों और डायरे रीज का ट्रै क रखता है?   

*
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.rt

.rtf

.rtfs

.rtes

1/1

current state of the computer is saved on a hard disk

current state of the computer is saved on a digital versatile disk

current state of the computer is saved on Random Access Memory

current state of the computer is saved on a compact disk

1/1

F1

F2

F3

F4

27.What is the file extension of Rich Text Format files?
  रिच टेक्‍सट फ़ॉर्मेट (Rich Text Format) फ़ाइलों का फ़ाइल एटेंशन क्या है?  

*

28.In sleep mode, the ________.
  स्लीप मोड (sleep mode) में, कं प्यूटर की वर्तमान स्थिति कहाँ सेव की जाती है?   

*

29.To edit the content of a cell in MS-Excel 2019, press the _________ key
after selecting the cell.
  MS-Excel 2019 में, सेल के  कं टेंट को एडिट करने के  लिए, सेल को सेले करने के  बाद
_________ कुं जी दबाएं ।   

*
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To set the criteria used in generating the test inputs.

It is a checklist which need to be satisfied so that the software is considered
ready to be released to the production environment.

To know when the test planning is complete.

To ensure that the test case specification is complete.

1/1

World Wide Web (www)

Hypertext Markup Language (HTML)

Dynamic Host Control Protocol (DHCP)

File Transfer Protocol (FTP)

30.What is the purpose of test completion criteria in a test plan?
  परीण योजना (test plan) में परीण पूरा करने के  मानदंड का क्या उद्दे  है?  

*

31.The _______ protocol is used for uploading files on the server.
  सर्वर पर फ़ाइलें अपलोड करने के  लिए _______ प्रोटोकॉल का उपयोग किया जाता है।  

*
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It will count the number of cells that have exactly 5 characters, and end with the
letter "s" in cells A1 through A7.

It will count the number of cells that have exactly 7 characters, and end with the
letter "s" in cells A1 through A7.

It will count the number of cells that have exactly 5 characters, and end with the
letter "s" in cell A1.

It will count the number of cells that have exactly 5 characters, and end with the
letter "s" in cell A7.

1/1

PPT

URL

WWW

HTML

32.What will happen when the formula “=COUNTIF(A1:A7,"????s")” is
executed in MS-Excel 2016?
  जब MS-Excel 2016 में सू "=COUNTIF(A1:A7,"????s")" निष्पादित किया जाता है
तो क्या होगा?  

*

33.A user has to enter _______ to navigate any website.
  किसी भी वेबसाइट पर नेविगेट करने के  लिए उपयोगकर्ता को _____ वि (enter) करना
होगा।   

*
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(i) False (ii) True

(i) False (ii) False

(i) True (ii) True

(i) True (ii) False

1/1

Final Showing Markup

Final

Original

Original Showing Markup

34.State whether the given statements related to MS-Excel 2019 are true
or false.
(i) The ribbon is located at the top of the screen and stretches across the
window.
(ii) The Home tab displays a variety of tools and features used to format
and move text.
  बताएं  कि MS-Excel 2019 से संबंधित दिए गए कथन स हैं या अस। (i) रिबन
(ribbon), स्क्रीन के  शीर्ष पर स्थित होता है और पूरे  विंडो (window) में फै ला होता है।
(ii) Home टैब, टे को फॉर्मेट और स्थानांतरित करने के  लिए यु किए जाने वाले विभि कार
के  टू ल और फीचर्स को दर्शित करता है।   

*

35.In MS-Word 2019, which view displays the original document without
tracked changes and comments showing? However, any tracked changes
orcomments in the document that have not been accepted, rejected, or
deleted remain in the document.
  MS-Word 2019 में कौन-सा व्यू (view), ट्रै ड चेंजेस (tracked changes) और
कमेंट्स को दिखाए बिना मूल डॉक्यूमेंट को दर्शित करता है? हालाँकि, डॉक्यूमेंट में कोई
भी ट्रै ड चेंजेस या कमेंट्स जिन्हें स्वीकार, अस्वीकार या डिलीट नहीं  किया गया है, वे
डॉक्यूमेंट में ही रहते हैं।  

*
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=SUM(A9:A15) * SUM(K9:K15)

=SUM(A9:A15) * 10

SUM(A9:A15)-B4/10

SUM(L9:L12) * SUM(K9:K12)/(10-10)

1/1

Ctrl + R

Ctrl + J

Ctrl + T

Ctrl + L

1/1

Tabs are not embedded in your document’s text

Tabs are hidden formatting characters, similar to space characters

Tabs are hidden formatting characters, but are not similar to space characters

Tabs are viewable formatting characters

36.Which of the following formulas when executed will give an error in
MS-Excel 2019?
  MS-Excel 2019 में, निम्नलिखित में से कौन-सा सू निष्पादित होने पर त्रुटि देगा?   

*

37.What is the keyboard shortcut for justified alignment in MS-Word
2019?
  MS-Word 2019 में, जस्टिफाइड अलाइनमेंट के  लिए किस कीबोर्ड शॉर्टकट का
उपयोग किया जाता है?  

*

38.What do you understand by the term 'tabs' in the context of MS-Word
2010?
  MS-Word 2010 के  संदर्भ में 'टैब (tabs)' श से आप क्या समझते हैं?   

*
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only downloading files

only uploading files

merging files

transferring files between hosts over internet

1/1

A framework for naming your files.

A framework which helps in transferring data from one file to another.

A framework which does not relate to other files.

A framework which describes how files are unrelated to other files.

1/1

The page orientation is Landscape.

The page orientation is in Default.

The page orientation is Portrait.

The page is vertically aligned.

39.FTP is used for ______.
  FTP का उपयोग ____________ किया जाता है।  

*

40.What do you understand by file naming convention?
  फ़ाइल नामकरण परिपाटी (convention) से आप क्या समझते हैं?  

*

41.If the width of the page is less than the height of the page in an MS-
Word document then which of the following statements would be FALSE?
यदि MS-Word डॉक्यूमेंट में, पेज की चौड़ाई पेज की ऊं चाई से कम है, तो निम्नलिखित में
से कौन-सा कथन गलत होगा?  

*
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URL modification

URL support

URL balancing

Canonicalization

1/1

URL support

DNS Resolution

URL balancing

URL modification

42.What is the process in which a preferred version of a page is selected
over multiple other versions when searching for webpages?
  वह कौन-सी क्रिया है जिसमें वेबपेजों की खोज करते समय एक पेज के  पसंदीदा वर्जन
(preferred version) को कई अ वर्जनों की तुलना में चुना जाता है?  

*

43.Replacing an IP address (http://208.77.188.166/) with a domain name
(http://www.example.com/) is a ___________process.
  एक IP एड्रे स (http://208.77.188.166/) को डोमेन नाम
(http://www.example.com/) से बदलना, एक ___________ क्रिया है।  

*
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CONCATENATE

JOIN

MERGE

COMBINE

1/1

IF()

VLOOKUP()

SQRT()

DATEVALUE()

1/1

absolute reference ($A$1)

absolute row reference (A$1)

relative reference (A1)

absolute column reference ($A1)

44.Which of the following text functions of MS-Excel 2019 is used to join
two or more text strings into one string?
MS-Excel 2019 के  निम्नलिखित में से किस टे फ़ं न का उपयोग दो या दो से अधिक टे
स्ट्रिं  को एक स्ट्रिं ग में जोड़ने के  लिए किया जाता है?

*

45._______ is the logical function used in MS-Excel.
  ______ is the logical function used in MS-Excel.

*

46.In MS-Excel 2019, after pressing F4 key twice, the cell reference
changes from A1 to _______.
  MS-Excel 2019 में, F4 कुं जी को दो बार दबाने के  बाद, सेल संदर्भ (cell reference)
A1 से ________ में बदल जाती है।

*
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micro

macro

trigger

entity

1/1

Insert -> Options -> Customize Ribbon

File -> Options -> Customize Ribbon

Design -> Options -> Customize Ribbon

View -> Options -> Customize Ribbon

1/1

57

97

53

65

47.In MS-Excel, a/an _______ is an action or a set of actions that you
record and can run as many times as you want.
  MS-Excel में __________ एक एन या ए का एक समूह है जिसे आप रिकॉर्ड करते हैं
और जितनी बार चाहें उतनी बार उसे रन (run) कर सकते हैं।  

*

48.Identify the sequence of steps used in MS-Excel 365 to enable the
Developer tab.
  MS-Excel में __________ एक एन या ए का एक समूह है जिसे आप रिकॉर्ड करते हैं
और जितनी बार चाहें उतनी बार उसे रन (run) कर सकते हैं।  

*

49.The ASCII value of decimal 5 is _______.
  डेवलपर टैब को एनेबल (enable) करने के  लिए MS-Excel 365 में उपयोग किए जाने
वाले चरणों के  अनुम (सीक्वें स) की पहचान करें।

*
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A

B

C

D

1/1

12

17

15

14

1/1

AND

NOT

OR

AT

This content is neither created nor endorsed by Google. - Contact form owner - Terms of Service - Privacy Policy

Does this form look suspicious? Report

50.The hexadecimal equivalent of decimal 10 is _______.
  दशमलव संख्या (decimal number) 10 का हेक्साडेसिमल समतु (hexadecimal
equivalent) _______ है।  

*

51.The octal equivalent of decimal number 15 is _______.
  दशमलव अंक (डेसिमल) 15 का अक समतु (ऑल एक्विवैले) _______ है।   

*

52. Which function of MS-Excel 2019 returns TRUE if any argument is
TRUE?
  Ms-Excel 2019 का कौन-सा फ़ं न, किसी भी आर्गुमेंट के  TRUE होने पर TRUE
लौटाता है?  

*
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